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Kab N Virtual Recording Studio: Reason1

Aim:  To create a piece of music using Reason 2.5 Software.

Outcomes:
1. A basic understanding of how to Create, Record, Play & Modify Audio and MIDI

using Reason.
2. An understanding of MIDI Sequencing in relation to Reason Devices.
3. An understanding of Sequencers, Samplers, and Digital Mixing.
4. Creation of a piece using Reason.

Preparation
• Become familiar with the Electronic Music Lab and basic operation of Macintosh

computers.
• Become Familiar with the Reason Tutorial CD-Rom available in the lab.  For more

information and a different, web based approach to Reason, go to
http://www.propellerhead.se/ and select ‘Close-up on Reason’.  From the list of
instruments, select ‘The Rack” which includes a simple tutorial which complements the
lab.  Another very good web based resource for Reason can be found at
http://www.reasonfreaks.com/.

• Find a piece of music (original or existing, with score or without, but preferably without
vocals), in a popular, techno, house, rave, trance or similar style.  You will be constructing
this music in Reason for part 2.

Equipment
Hardware Lab Bay in 140 which includes MK-249 USB MIDI keyboard controller.
Software PropellerHead Reason 2.5.

Background
The activities and instructions in this section (up to the beginning of Part 1) are optional but
will give you a basic introduction to Reason, its structure and a few of its fundamental
components.  If you have examined the Reason Tutorial, this section should also be
redundant.  However, you should answer the questions posed in this section.

WHAT IS REASON? WHAT DOES IT DO?
Reason is primarily a Digital Recording Suite, which emulates (has a look and feel of) real
life equipment found in a recording studio (hence ‘virtual recording studio’).  This program
then utilises Audio Sampling, Digital Mixing, and MIDI Sequencing to create music.  The
main features of Reason are the ‘Rack Devices’ that manipulate audio and MIDI to create
easily ordered sounds.  We will begin by giving a brief outline of Reason and its device’s, as
well as basic operations.

The following sections list the overall anatomy of Reason (Audio/MIDI interface, Mixer,
Sequencer), including some of the effects devices you can add to your ‘rack’ of virtual
instruments.  To add an instrument/device, you choose the item you want from the Create
                                                  
1 This lab is based on the of work Sam Wright, a graduate of the Advanced Electronic Music Course, at the
School of Music and Music Education, UNSW.  His original submission was an option from that course.  This
student’s notes were adopted because of the excellent quality of the work.

Your name __________________________________



menu.  The order in which you choose your devices can be important,  In general, you should
add the mixer first, followed by the effects you may want to use, followed by the individual
devices.  Within the addition of each device there may also be some recommendations for
order of addition,  This will be discussed in Part 1 of the lab.  By following the order of
addition the virtual cabling will be done automatically and logically, without you having to
manually reconnect the virtual cables.

If you press the TAB key on the computer keyboard, the whole display of the rack of
instruments will swing to the back, and you will see all the ‘patch cables’ from all the devices
going into the mixer.  You can alter any of these to go wherever you want them to just by
clicking on them, and while holding down the mouse, drag the cable to its new ‘home.’  By
doing this we can send different effects to different channels of the mixer, or send different
devices playing into each other.  So as you add devices to the mixer, you may wish to
examine the default cabling.  While novice users may wish to avoid this, it is still
recommended that you use the tab key to observe cabling and hence get a feel for how audio
cables in studios and within racks can be interconnected.

For more information about any of the Reason Devices available, go to
http://www.propellerhead.se/ and select ‘Close-up on Reason’

AUDIO/MIDI INTERFACE
The audio/MIDI interface is the main component that communicates from the computer to the
keyboard/speakers etc.  It controls the MIDI signal coming in from the keyboard, and sends
the audio out to the computer.

You may need to check to make sure the external MIDI Keyboard (such as an MK-249) is
recognised by the computer and Reason.  To check that Reason can ‘see’ the MK249
keyboard:
Go to The Reason menu, then Preferences.  Click on MIDI, and Advanced MIDI, and
select MK-249 Keyboard from the pull down menus.  The MIDI Keyboard is now set up.

MIXER 14:2
The Mixer is the other main component of the Reason Program.  It controls the levels, effects,
EQ, and master volume of your soon to be composed piece.

SEQUENCER WINDOW
Everything recorded within Reason can be seen in the Sequencer Window.  We can edit,
paste, copy and do all sorts of things in this window.  It is situated at the bottom of the -
program with tracks on the left, and what is being played/recorded on the right.  It will be
referred to constantly in this tutorial.  It is possible to ‘tear off’ the sequencer into a separate
window.  Explore the menu and see if you can find out how to do this.
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How can the sequencer window be displayed separately and independently from the rack?

__________________________________________________________________________

EFFECTS: RV-7 & DDL-1, SCREAM 4

In Reason you can add different effects just by clicking.  If we wanted
to add some Reverb, or Delay to the overall sound coming out of the
mixer, just click on the mixer.  Then got to Create, and from the pull
down menu select RV-7 and DDL-1 respectively.  This then adds
reverb and delay to the mixers Return partition on the right, and you
can alter how much you want of each effect in the main mix.

To Add These effects to the ‘sound’ of a Rack Device, just alter the
RED SEND DIALS above the Device’s Track on the MIXER!

SCREAM 4 –Sound Destruction Unit

This device produce the effect of a distortion stomp box commonly used by rock guitarists.
Just select the device you want this extra effect added to, and select Scream 4 from the
Create menu.  It will be automatically attached to the unit you selected (use the tab key to
check and press tab again to return to the front of the rack).

You can adjust the level, type, and the EQ of the distortion you want.  You also get a range of
what guitarists call ‘Amp Simulators’ such as TUBE, FUZZ, and OVERDRIVE etc.  Then if
you want a part of your song without this effect, during or before recording you can hit the
Bypass button, and it turns off the rack device.

You can then select the body button and adjust the TYPE of distortion again.
The MASTER dial at the right of the rack device provides control of the final level coming
out of the effect before being sent to the mixer.

Patch’s can also be added to this device by hitting the Patch Browse Button, and then
navigating through the Reason Factory Soundbank for the required patch.

Bypass Button
Patch Browse
Button

Scream EQ



Part 1
Launch Reason by clicking on the Reason icon in the Dock.

From the File menu select Open and find the file called Empty Rack.rns (or similar)
from the file menu.
Make sure that the file opened is an empty rack containing only an AUDIO/MIDI interface.

Go to Create, click on Mixer 14:2 (the first step you would nearly always complete when
starting a new Reason project), then go to Create again and select RV-7 and DDL-1
from the pull down menu.
This sequence of instrument additions connect the mixer and the effects we will use.  Now we
will add additional Reason virtual instruments which can generate sounds.

Go to Create and select the Re-Drum Computer.  We now can start programming in a
drum loop.

Go the Sequencer Window and put the L cursor at 1, and then put the R cursor at 13.
This sets up the 12 bars we will need for our Blues Progression that will be created.

The sequencer Window may be thought of as the recording device (eg. a multitrack tape
recorder) in a recording studio.  To make a ‘permanent’ record of a sound-recording session,
this is where you put it.  The window is more complex and powerful, but for now this analogy
may help explain its function.

Creating a beat pattern using RE-DRUM DRUM COMPUTER

The Re-Drum device in Reason is a virtual drum machine.  You can create any rhythm with
you desire.  You have predominantly TWO main ways of doing this.
By clicking on the Patch Browse Button, then clicking on Reason Sound-bank button, you
can navigate through the Reason Factory Sound-Bank to the Re-drum Samples and choose
the sample called Tight Kits ->Dublab TightKit.drp

Once the patch has been selected, click the mouse on the Select button in Track 1 of Re-
Drum.  Then click on the white buttons labelled 1, 4, 7, 8, 10, 15, and 16.  Press the RUN
button and listen to the Bass Drum playing our loop.  We can also add accents by
clicking the Dynamic Switch to HARD.  Do this then click on numbers 4, 7, and 16.  This
should accent these beats.

This is the
Patch Browse
Button

Select Button

Run Button
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Click on the Select button in Track 2 (snare drum), and click on the white squares
numbered 5, 6, and 13.  Press the RUN button to check what you have entered.
The “Track” number corresponds to a column or channel number on the device.

Click on the Select button in Track 3, and click on the white squares numbered 10 and
11.

Click the Select button in Track 8, and click on the white squares numbered 1, 3, 5, 7, 9,
11, 13, and 15.

To hear any of these by themselves hit the Solo button, which is a small ‘s’ at the top of
each track.  Then hit the Run button.

Click the select button for Track 9 and hit the white buttons 5, 6, and 14.  Then Accent
6, and 14, as HARD, and 5 as SOFT.

Your Drum Loop is now complete.  Save your work at regular, frequent intervals.

Select Save As… from the File menu, save it with a sensible, easily identifiable, easy to
find name (such as the short name of your group members) to the Student Work folder
or volume.

An alternative way of listening to this drum pattern is by recording or transferring it to the
virtual Sequencer (the Sequencer Window mentioned above).

In the Sequencer Window click on the Edit Mode/Arrange Button so that you go into the
Edit mode.
This Button acts as a ‘toggle’ meaning that it will swap the Sequencer between the Edit mode
and the Arrange mode.  The Edit mode allows you to take a close look at each of the things
you have recorded, including making edit with a high level of precision and flexibility.  The
Arrange state allows you to manipulate larger blocks and multiple tracks of recorded
information.

You should now have another row of buttons that allows you to manipulate the MIDI
information of the drum loop.  If not, press the Edit Mode/Arrange button again.  This allows
you to write in the loop manually, rather than program it in as above.

Edit Mode/
Arrange
Button

Use these tools to edit,
copy, paste, and zoom.These cursors are

involved with Playback,
and L&R Looping



The buttons are the a) Key Lane, b) Rex Lane, c) Drum Lane, d) Velocity Lane, e) Pattern
Lane, and the f) Controller lane.

Click on the Rex Lane Button and make sure it is the only button pressed ‘on.’
If you put the mouse on the “Slice” names on the left hand column you will see it turns into a
small speaker.
Click on a “slice.”
A ‘sample’ from the Re-Drum Computer plays.  In the events listing on the right [lines of
squares] you can enter the pattern you want, with the sounds you want, at the exact time you
want.  If it is not playing, you may need to change tools.
By clicking on the Snap to Grid Button, all your work will stay in time.  But you can also
click on a button and select the divisions of the events list such as 16th notes, 8th notes etc.
Let’s call it the Divisions Button.

We are not going to compose using this method, this for later reference.

Once one pattern is written in why keep it that way?
You can copy your first loop and paste it in other banks
such as A, B, C, or D, and their numbers 1-8 to create
variations, fills, breakdowns etc.  We won’t do this is
this tutorial.

Creating an blues accompaniment track using DR-REX LOOP PLAYER
The Dr-Rex Loop Player plays audio loops and allows you to alter them in any way you want.
We will experiment with two ways.

Go to Create, and select Dr-Rex Loop Player from the menu.

Go to the REX’s Browse Patch Button, click on the Soundbank Button, and open the
Reason Factory Soundbank and go to Music Loops.  Then navigate to Variable Tempo -
> Downtempo Loops -> 090 FunkyStrat2_mlp.

DR-Rex will open it for you.  Click on the Preview button on the REX player to hear the
loop!

The Lane Buttons A through to F
Respectively…

The Divisions Button.

Snap To Grid Button
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Click on the To Track button to put a visual representation of the loop automatically in
the Sequencer Window.

Go down to the Sequencer Window, and click on the track called “DR-REX 1.”  Make
sure it is selected and that it has a MIDI jack symbol next to it.

Double click on the name of the track in the sequencer window and call it BLUES
GUITAR LOOP.
Notice both the rack device, and the mixer now call it this.
[HINT:  You can Go back and Name the Drum Computer too as FUNKY KIT…it always
helps when looking at the mixer later to tell what is playing what].

It may get boring just hearing this over and over so let’s do something to alter this loop.
While it is playing, EXPERIMENT/PRACTICE with the keyboard ON THE Rex Loop
Player’s SCREEN.  For example, play a I, IV, V 12 Bar Blues progression in C MAJOR
What is 12 Bar Blues?  Play C for 4 bars , F for 2 bars, C for 2 bars, then G for 1 bar, F
for 1 bar, and C for 2 bars.
The roman numeral I refers to a C chord (so you play the notes C, E and G simultaneously).
The F (or IV) means playing the notes F, A and C.  And the G (or V) means playing G, B and
D.
Use the keyboard ON THE Rex Loop Player’s SCREEN while you Preview the Loop.
If you are having difficulty playing this, don’t worry.  This is for practice (you will record in a
moment).  If you are really having difficulty, you could just play single notes instead of
chords (that is, 4 Cs, then 3 Fs, then 2 Cs, then a G and an F).  See also the table below for
some setting ideas on the Transport bar.  However, if you are finding this terribly easy, make
the accompaniment more interesting by, for example, introducing 7th chords.

Settings on the Transport Bar which may help make recording easier:
TEMPO:  To alter this, just adjust it to 110 in the transport bar down the bottom.  This will
make it groove more.  However, if you are having difficulty playing the part, slow the tempo
down for recording,
LOOP:  Put on the LOOP button.  Then Adjust the Cursors in the Sequencer Window called
L & R, from the beginning to the end of your Blues progression.  Press PLAY and Reason
will play the Drum Loop, and Blues Loop over and over and over and over…
TIME SIGNATURE:  This can also be altered here in the transport, and automatically puts
everything into this time signature.

We now will record the Blues to the Sequencer Window.
Go to the Transport Bar [this controls all playback of music in Reason], press
RECORD, and then press PLAY.

MIDI Jack Symbol



While the piece is playing any changes you make to the loop in the Rex Player will be
recorded.
Play a 12 Bar Blues Pattern as you practiced above.
Play it back by pressing PLAY on the Transport Bar.  Notice the Drum loop fits in time
with the Guitar Loop!
If you make any mistakes, Select UNDO from the Edit Menu and just Record again!
You now have a Drum Loop and a Blues Loop.
SAVE YOUR WORK

Adding a bass line using an SUBTRACTOR SYNTHESISER
Go to Create, and select SUBTRACTOR Analog Synthesiser from the menu.
We are going to take a simple audio sample, and with this sampler create a bass loop for our
song.
Double click on the Subtractor track in the Sequence Window and name this device
Bass Loop.
Make sure the MIDI Jack symbol is showing next to our new track.

The Matrix – which drives the Subtractor Synthesiser (and some other devices) as though it
were a mini-MIDI-sequencer, is shown here:

Now we add an extra device which is dedicated to the Subtractor and is called The Matrix so
that we can ‘drive’ it to play sounds.  Yu can think of The Matrix as being the Subtractor’s
own little sequencer.

Select The Matrix from Create, after clicking on the Subtractor first.

Why do you need to make sure the Subtractor is selected before Creating The Matrix?  ____  

  _________________________________________________________________________  

To set up a bass loop, the matrix acts like a digital picture composer.  The Subtractor plays
the audio sample, and the matrix uses MIDI sequencing to tell the Subtractor to play the
sound in a certain order.
Now we need to set up a sound (or ‘sample’ or  ‘patch’) for the Subtractor.
Go to the Patch Browse Button, navigate through the Reason Factory Soundbank
through the Subtractor Patch list, right to Bass, and then select Picked Bass.
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Our patch is now selected, and we use The Matrix to program in the bass loop.
The process of programming The Matrix is simple.  Follow these five steps:

1. You click on the VELOCITY LANE first to get the volume and attack up.  [This
lane allows you to have softer and harder attacked notes].

2. You click in the notes you want the Subtracter to play in line with the keyboard
provided.  You can go up and down octaves by hitting the OCTAVE BUTTON
etc.

3. You can program many different BANKS A-D with 8 numbers in each like the
Re-drum Computer

4. You can select whether you want the matrix to process 8th notes [quavers] or 16th

notes [semiquavers] etc, by hitting the RESOLUTION DIAL.
5. The STEPS button also allows you to program within Bars.  [Here have it at 16

steps, hence 4 bars].

Now we shall write the Bass Loop:

Drag the mouse over all the Velocity Lanes to get the sounds up
Then using Arpeggios (eg: C, E, G etc) going UP & then DOWN type them in on the
matrix as seen above with the red dashes, in line with the keyboard on the left.  Make
the C arpeggio go the whole 16 steps = 4 Bars.
Then Clicking on The Matrix, go up to Edit, and select Copy Pattern.  Then select
BANK A Patch 2, and going up to Edit select Paste Pattern.  Then Paste it again into
BANK A Patch 3.

What are the keyboard shortcuts for copying and pasting patterns?  ____________________  

  _________________________________________________________________________  
Now select BANK A Patch 2 and press APPLE U {Or, go to the edit menu and select
SHIFT UP} until the first note C becomes a F.  Then repeat this process with BANK A
Patch 3 and make the first note C, a G.
This completes all the arpreggios for the Bass Loop.
To set down what we have created in the Sequencer Window, hit the RECORD button,
and then press PLAY.
While the song plays, the Subtractor will play the Loop from The Matrix with the Picked Bass
sound.

Banks &
Patches

Resolution
DialVelocity Lane –with

different attacks as seen
Octave Switch



All you have to do is when the correct chord progression comes up hit the BANK A Patch 2
button for the IV chord, and then for the V chord etc, Right through the Blues Pattern.
Only do one whole Blues Progression for this is all you need.
And you have created a full working Blues Bass Loop.
Double click on the SUBTRACTOR in the Sequencer Window and name it as the BASS
LINE.  SAVE YOUR WORK.

If you wish to fiddle with its overall sound feel free to use the effects on the Subtractor itself.

Adding a brass blues line using the NN-19 DIGITAL SAMPLER

Create a NN-19 DIGITAL SAMPLER from the Create menu.
This sampler takes any sound (or ‘patch’) and modifies it/plays it back as you want it to
sound.
Click on the Patch Browse button and navigate to the Reason Factory Soundbank and
NN-19 Sampler Patches, select Brass and Woodwind, then grab the BrassEnsVelFlt
patch.

Patch
Browse
Button

Select a
different
sound wave

You can trigger
the patch at any
pitch on this
keyboard, or a
MIDI Controller
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We now have a Brass Ensemble Patch.

Double click on the NN-19 name in the Sequencer Window, and call it the BRASS
BLUES LINE.
Also make sure the MIDI Jack is in the same window as the BRASS BLUES LINE.

What does the MIDI Jack icon signify?                                                                                                        

Is it possible to make a sound recording of your own sample and include it as a patch for the
NN-19?  If so, how might it be done?                        

You now can use your own musical expertise:

Practice a melody line
Using the C Major Blues Scale [1C, b3Eb, 4F, b5F#, 5G, b7Bb, 8C], create a BRASS
BLUES LINE that fits the funky nature of the piece.
It is best for each chord such as C, F, and G, to have one repeating pattern like C, Eb, C, Bb,
C. and so on…
If you are struggling, consider playing just a couple of notes from the blues scale, such as the
C and E flat repeatedly and rhythmically.
Experiment till you have something in working order, then Press RECORD and then
PLAY and play your Brass Line in.
If you make a mistake hit UNDO in the Edit menu, and just record again!

Add effects.
We want some REVERB on the brass … You can add this effect to the Brass by adjusting the
Red Dials above the Brass’ Mixer Track on the MIXER (the first device created).
Also Adjust the REVERB unit to a special ‘Room,’ such as the ‘Medium Room’.

SAVE YOUR WORK

What happens if you click the solo button on the channel corresponding to the NN-19 of the
mixer at the top of the rack?                                                                                                                        

NN-XT REMOTE EDITOR

The NN-XT is also a type of Digital Sampler.  It takes a sound/Patch, and allows you to play
it on your MIDI keyboard controller, such as the MK-249.

Select the Wurlitzer patch from the Piano directory in the Reason Factory Soundbank
(following the procedure described in previous sections).
Double click on the NN-XT track in the Sequencer Window and name it the Wurlitzer.
Make sure the MIDI Jack is visible.



We are going to use this Patch to first play chords, then do a solo on the C Major Blues Scale!
Copy the whole arrangement in the Sequencer Window [Select ALL from Edit Menu],
then go forward in the arrangement by 12 bars, then at the END of these extra bars
[what will soon be the BREAKDOWN], PASTE the Whole Arrangement.
That is, you should have an empty gap of bars surrounded by the bars you pasted.  It would
look like this with a 12 bar BREAKDOWN in the Middle:

For the first 16 bars just play the I [that is, the notes C, E & G simultaneously], IV [the
notes F, A & C], V [G, B & D] Chords in C Major.  Remember to Press RECORD, then
PLAY to record what you play on your MIDI KEYBOARD.

Select the PENCIL TOOL and drag over the bits you have recorded from left to right.
It forms a long BAR of colour - this is what you recorded.  Just select it with the cursor,
COPY this and PASTE it on the LAST 12 bars of the Song

We now have Chords for the 1st and 3rd parts of the song.

We want the Bass to play in the Middle Part of the song so select the PENCIL TOOL,
click and drag across the MATRIX BASS TRACK in the Sequencer Window, Press
COPY, and then PASTE it at BAR 13 so the Bass Loop still Plays its Blues Line in the
BREAKDOWN.

We now have a Bass Loop BREAKDOWN.

Put the L & P Cursor on BAR 13 in the Sequencer Window, and R on BAR 25.
This will loop the SOLO we are about to record.

Using the C major BLUES SCALE (discussed above), play a 12 BAR SOLO and record
it.
If you are having difficulty soloing, remember that very simple improvisations can sound
good.  For example, you can even just repeat the note C several times, and have gaps with no

Tools Bar with Cursor, Pencil,
Eraser, Line Tool, Zoom
Tool, Grab Tool respectively.
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sound.  Then if you are feeling brave enough, you could start repeated C and E flat notes.
Another approach is to rest your fingers on a selection of the blues scale notes and start
pressing keys at will, but with a strong rhythmic sense.  Remember that silences intermixed
with notes can sound good, too.
Select the WURLITZER track, and make sure the MIDI JACK is present.  Then Press
RECORD, then PLAY.

If you were not happy with what you have recorded, describe at least two things you could do

to fix up the problem.   _______________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

Select the PENCIL TOOL, and click and drag across what you recorded.
This forms another BAR of COLOUR to show what you have recorded.

So it sounds good?  Now let’s make it WET.  Which means we add some DELAY and
REVERB effects to the WURLITZER track on the Mixer.   The RV-7 and DDL-1 are already
on the rack immediately below the mixer so you don’t need to Create them.
Just adjust the RED AUX DIALS above the TRACK named WURLITZER on the
mixer at the top of the rack.
The dials should be ONE, and TWO, because above the MASTER LEVEL you can see the
EFFECTS are on RETURN DIALS ONE, and then TWO.
Put the ONE dial at 12 O’Clock (i.e. pointing directly up), and the TWO dial at 9 O’Clock
(i.e. pointing to the left).
Now play it back and press the SOLO button on the TRACK to hear the amount of
effect you have added.

Then unpress the SOLO button and the whole song comes back in!
SAVE YOUR WORK

Colour Bars
Pull Down Menu that
Connects Devices



Adding a sustained chord progression to the Breakdown, using a second NN-19
DIGITAL SAMPLER

Create a 2nd NN-19 Sampler and then navigate through the Reason Factory Soundbank
to the NN-19 Patches, ORGAN patch, then the ORGAN B3 sample.

Double click on the corresponding line in the Sequencer Window and name the track
ORGAN DONOR.

We are now going to record a sustained Chord Progression over the BREAKDOWN.

Practice playing the chords over the BREAKDOWN first.

Keeping the Cursors in the Sequencer Window where they are, press RECORD then
PLAY, and using your MIDI KEYBOARD play the I, IV, V [C, F, G] progression on the
ORGAN B3 sound!

Use the PENCIL TOOL to create a BAR of COLOUR, and COPY it.

PASTE this on the Last 12 Bars of the Song.
So the Organ starts at the BREAKDOWN, and continues to the end of the song.

Dials that control the
amount of EFFECT on
this track

EQ band for
adjusting sounds

MUTE and SOLO buttons
respectively

This is the PANNING dial.  You
can send the track to the left or
right hand speakers [and automate
this which will be explained in
MIXING]

Main Volume Fader for
this Track
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Now move the L & R cursors of the Sequencer Window to the Beginning and End of the
Song.  And we have completed a 36 bar piece (‘song’).
SAVE YOUR WORK

How can you save the song so that it can also be played independently of Reason?  _______  

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

MIXING
We have now completed our song!  All that is left is mixing the song and saving it as a
REASON SONG.
Mixing involves us getting all the levels right so we can hear each individual instrument
properly and hence the song sounds great!

Go through your piece and adjust all the Main Level Faders for each track so you can
hear each instrument clearly.
Tip to get a good mix: Loop the song, and while doing so bring the main levels on the mixer
down to a fairly low level (this makes it easier to hear if any part is a bit louder than other
parts).  Listen for any part that you can hear as being slightly louder than other parts and bring
the slider down for that part.  Repeat the process until no part stands out.  See also the Reason
Tutorial for some excellent tips on getting a good mix.
Next we are going to make adjustments during the song.
You can make levels go up and down automatically while RECORDING the song.  This is
called AUTOMATION.

Once you have altered all the levels so the song sounds good, go to Create and select
SEQUENCER TRACK.  Name it as AUTOMATION in the Sequencer Window.
From the Pull Down menu in the Sequencer Window select MIXER 1.

We are going to make the ORGAN crescendo at the end of the BREAKDOWN, then really
soft to loud again for the 3rd Part of the Song.
We are going to make the WURLITZER SOLO crescendo in the BREAKDOWN also.

Make sure the MIDI JACK is in the AUTOMATION TRACK.  Then Press RECORD,
and press PLAY.  Then as you record, change the TRACK LEVELS of the

Select “MIXER 1”



WURLITZER and ORGAN by clicking the mouse on them and dragging them up and
down.
[Hint:  Loop the Middle and Last part of the song to make it easier].

Once recorded, then play it back and watch the MIXER levels rise and fall by themselves!

Repeat this Process with the end of the song, this time gradually pulling DOWN the
MASTER LEVEL of the Mixer for a FADEOUT.

We are going to AUTOMATE some PANNING for the BRASS BLUES LINE.  Refer to the
Diagram above for the PANNING DIAL.

Hit RECORD, then PLAY, and while recording move the PANNING DIAL in the
BRASS BLUES LINE track on the mixer with your mouse.
MOVE it so each Stab by the brass is either on the left or the right.
Once you have recorded this, play it back and watch the PANNING DIAL move around.
SAVE YOUR WORK

Is it possible to control and edit automation?  If so, how? [Hint: explore the Controller button

in the Sequencer Window – but be sure to save your work first!] _____________________

_________________________________________________________________________

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

  _________________________________________________________________________  

Once all of this has been completed and you are happy with how the song sounds as a
whole go up to File and select EXPORT SONG AS AUDIO FILE.
You are asked to name your song and where you want to save it.  Navigate to the student
work folder, name your song so that it includes the names of your group members,
choose AIFF from the Type menu, and press SAVE.

Then once it has saved, go to where you saved the Audio file in the Finder (select Hide
Reason from the Reason menu if necessary – you can return to Reason by clicking Reason on
the Dock), and find your song in a standard AIFF file ready to burn to a CD.

Burn the audio file and the Reason Song file to CD.
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If you like, you can save the audio file as an audio CD so that you can play it on an audio CD
player, rather than just a computer.

Checkpoint for demonstrator use
Student can build a rack of instruments                                                                                   [            ]

Student can operate devices                                                                                                     [            ]

Student can program tracks                                                                                                     [            ]

Student can edit in sequence window                                                                                      [            ]

Student can control effects                                                                                                      [            ]

Student can use automation                                                                                                     [            ]

Student uses keyboard shortcuts regularly                                                                               [            ]

Work is saved and backed up in Reason and Audio formats                                                    [            ]



• 


